This document is a supplement to the MapXtreme 2005 Developer Guide. It covers what's new in v6.6, bug fixes, known issues, and other information. Refer to this document for release specific information and to the Developer Guide for overall product information and usage.

The Developer Guide is available in three formats and from several locations, including:

- Printed guide included in the MapXtreme 2005 product box
- PDF version accessible from the Start > All Programs menu under MapInfo > MapXtreme 2005 v6.6 > Learning Resources browser
- PDF version on the MapInfo website at http://extranet.mapinfo.com/support/documentation/manuals.cfm#mapxtreme0405
Installation

New to this release of MapXtreme 2005 is support for the Microsoft .NET Framework 2.0 and Visual Studio 2005. This is in addition to the support for the .NET Framework 1.1 SP1 and Visual Studio .NET 2003. One of the frameworks are required on your system before installing MapXtreme 2005. We also recommend that one of the development environments is already installed so that the MapXtreme 2005 installer can integrate its templates, samples and help system into the development environment.

The following are some key items to be aware of before you install MapXtreme 2005. See also Chapter 2: Getting Started, in the MapXtreme 2005 Developer Guide for information on types of installations (SDK or deployment), licensing and more.

Supported Environments

The following are tested and supported operating systems and development environments.

<table>
<thead>
<tr>
<th>Operating Systems*</th>
<th>Windows 2000 Professional Service Pack 4 (SP4)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Windows 2000 Server SP4</td>
</tr>
<tr>
<td></td>
<td>Windows 2000 Advanced Server SP4</td>
</tr>
<tr>
<td></td>
<td>Windows XP Professional SP2</td>
</tr>
<tr>
<td></td>
<td>Windows 2003 Server Standard Edition SP1</td>
</tr>
<tr>
<td></td>
<td>Windows 2003 Web Edition SP1</td>
</tr>
<tr>
<td></td>
<td>Windows 2003 Server Enterprise Edition SP1</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Development Environments †</th>
<th>Visual Studio 2005</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Visual Studio .NET 2003 (for C# and VB)</td>
</tr>
<tr>
<td></td>
<td>Visual Basic.NET 2003</td>
</tr>
<tr>
<td></td>
<td>Visual C# .NET 2003</td>
</tr>
</tbody>
</table>

* 32-bit systems only
† Suggested IDE’s. Others can be used, however, the MapXtreme installer will not integrate its templates, samples and help system.

Additional software requirements include:

- MDAC 2.7 or later (MDAC 2.8 is located on the MapXtreme 2005 product CD.)
- IIS 5.0 or IIS 6.0 (for web applications)
Minimum system requirements

<table>
<thead>
<tr>
<th>Memory</th>
<th>Windows Server 2003: 256 megabytes (MB) RAM</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Windows Server 2003 Web: 256 MB RAM</td>
</tr>
<tr>
<td></td>
<td>Windows XP: 256 MB RAM</td>
</tr>
<tr>
<td></td>
<td>Windows 2000: 256 MB RAM</td>
</tr>
<tr>
<td></td>
<td>Windows 2000 Server: 256 MB RAM</td>
</tr>
<tr>
<td></td>
<td>Windows 2000 Advanced Server: 256 MB RAM</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Processor</th>
<th>600-MHz Pentium III-class processor</th>
</tr>
</thead>
<tbody>
<tr>
<td>Video Card</td>
<td>Graphics card that supports at least 256 colors</td>
</tr>
</tbody>
</table>

Supported Databases include:
- IUS 9.3 and IUS 9.4
- Microsoft Access 97 and Microsoft Access 2000
- Oracle 9i, Oracle 9ir2, and Oracle 10G, Oracle 10Gr2
- Microsoft SQL Server 2000
- MapInfo SpatialWare® 4.8.1 for Microsoft SQL Server 2000
- MapInfo SpatialWare® 4.9 for Microsoft SQL Server 2000
- MapInfo SpatialWare® 4.9 for Microsoft SQL Server 2005

Visual Studio 2005 Express Editions

MapXtreme 2005 does not support the Express Editions of Microsoft Visual Studio 2005.

Side-By-Side Installations and Use

You may have more than one version of MapXtreme 2005 installed on your system at the same time. Each version of MapXtreme 2005 installs into its own directory.

You may also build a desktop and web application against an earlier version of MapXtreme and run it against a later version.

You may not, however, run ASP.NET applications built with different versions of MapXtreme in the same process space, as in the case of IIS 5.0 on Windows XP and Windows 2000 operating systems. Each application would require its own version of MapXtreme to be loaded into IIS 5.0’s single process space.

IIS 6.0 on Windows 2003 Server, however, can maintain multiple process spaces. To run your ASP.NET applications on the same computer, create an application pool for each version of MapXtreme 2005 and place the appropriate ASP.NET application in it. Restart IIS 6.0. When an application runs in its own process space, it will load the appropriate version of MapXtreme.

1. Assumes user accounts have associated schemas. See Data Access from SQL Server 2005 on page 13
This does not affect desktop applications created with different versions on MapXtreme. Each desktop application always runs in its own process space.

**.NET Framework Installation**

MapXtreme 2005 v6.6 requires the .NET Framework 1.1 with Service Pack 1 (SP1) or .NET Framework 2.0. You may have both frameworks installed if you wish. The MapXtreme 2005 installer will check for a framework and will prompt you to install one when neither Framework 1.1 or Framework 2.0 is found. The Microsoft .NET Framework installers are provided on the MapXtreme 2005 product CD.

**Install Visual Studio First**

It is recommended that before you install MapXtreme 2005 you should have Visual Studio .NET 2003 or Visual Studio 2005 installed.

**Note:** You may use other development environments, however, there will be no integrated MapXtreme 2005 templates, samples or help system.

**Windows 2000 SP4 COM+ Hotfix Rollup Package 27**

If you are running Windows 2000 and intend to use MapXtreme 2005 in a Web-based application, you must obtain the Microsoft Windows 2000 Post-Service Pack 4 (SP4) COM+ 1.0 rollup package 27. For more information, see the Microsoft KnowledgeBase Article - 822618 at [http://support.microsoft.com/?id=822618](http://support.microsoft.com/?id=822618).

**Permissions to Temp Directory and other Resources**

For deployed web applications, if you are using integrated security, make sure all users who will access the site have permissions on the temp directory and any other necessary resources. MapXtreme 2005 executes in the ASP.NET process space and this process executes using the security token passed from the IIS process. You will have to grant access to any user who will log in to this directory. If you are using anonymous access then you will have to grant access to the temp directory to the IUSR_LocalMachineName system account. MapXtreme 2005 obtains the path to the temp directory from the current TEMP environment setting.

**VisualBasic Compiler Hotfix**

In Microsoft Visual Studio .NET 2003, when you try to create a new Visual Basic project using a MapXtreme 2005 template, you may receive the following error message:

Visual Basic .NET compiler is unable to recover from the following error: System Error &Hc0000005& (Visual Basic internal compiler error)

A hotfix is provided on the MapXtreme 2005 product CD under \Install\VBCompilerHotfix for English, German, Japanese, Chinese-Simplified and Chinese-Traditional locales. See also this Microsoft Support article: [http://support.microsoft.com/kb/836154/](http://support.microsoft.com/kb/836154/).
Upgrading to MapXtreme 2005 v6.6

An upgrade of MapXtreme 2005 v6.6 installs into its own directory. It will not overwrite a previous version. This allows you to maintain side-by-side installations of v6.6 with a previous release. A side-by-side installation requires that you copy your old license file to the new v6.6 location.

If you are downloading the Trial version from the MapXtreme website, follow the posted upgrade instructions. You must have a previous version of MapXtreme 2005 (v6.5) or MapXtreme 2004 (v6.0, 6.1, or 6.2) installed in order to install v6.6.

Note, when using a side-by-side install, you must close Visual Studio before opening a MapXtreme project of a different version. For web applications that use IIS, you will need to reset IIS (use the iisreset.exe command in a console window or from the Start > Run menu option.)

Refer to the MapXtreme 2005 Developer Guide for more information on updating desktop and web applications.

Deploying Applications

MapXtreme 2005 supports two strategies for deploying applications:

- Use the provided MapXtreme 2005 runtime installer.
- Use the provided MapXtreme 2005 merge modules that you incorporate into your own installer.

With the runtime installer, the required MapXtreme 2005 assemblies and registry entries are installed to the deployment computer. Then you are ready to run your setup.exe containing your MapXtreme 2005 application. Install the runtime from the MapXtreme 2005 product CD (from the Install page, choose Deployment Installation). You must have a .NET 1.1 or 2.0 Framework installed on the deployment computer (available on the MapXtreme 2005 product CD).

If you are building a custom installer, you add only the assemblies you need for your application by including redistributable MapXtreme 2005 merge modules in your setup.exe or .msi project.

**Note:** MapXtreme 2005 does not support the Visual Studio 2005 ClickOnce deployment option for Windows Forms applications. MapXtreme’s installer technology requires the MapXtreme assemblies be located in the global assembly cache (GAC). The ClickOnce installer technology cannot put assemblies in the GAC.

Refer to the MapXtreme 2005 Developer Guide, Chapter 2, for more information for deploying your MapXtreme application.

Merge Modules for Custom Installers

If you wish to create your own installer and control exactly what files you want to include, MapXtreme 2005 provides merge modules for this purpose.

MapInfoCoreEngine_6.6.msm (or the SCP version equivalent MapInfoCoreEngineIntl_6.6.msm) is the only required merge module you need for your desktop or web application. All other merge modules that ship with MapXtreme 2005 are optional. See the table Merge Modules Provided With MapXtreme 2005 on page 7 for a complete list.
Visual Studio automatically searches your project for .NET assemblies when you package your application and includes the installed merge modules that match those assemblies. ¹

For example, if your application uses custom symbols, Visual Studio will add MapInfoCustSymb.msm. If your application uses MapXtreme’s pre-built web controls, Visual Studio adds MapInfoWeb_6.6.msm to your project.

The MIFonts_6.1.msm, however, is not included automatically in your project. MapInfoCoreEngine does not require the fonts contained in this merge module. So if you want your application to use any of the MapInfo TrueType symbol font sets, you must add MIFonts_6.1.msm by hand.

**Note:** MapInfoCoreEngine_6.6.msm and MapInfoCoreEngineIntl_6.6.msm require a configuration module called MapInfoMXTConfig_6.6.msm. When you package the core engine merge module in your project, the configuration module is automatically included.

The following table lists the required and optional merge modules for applications built with MapXtreme 2005. Modules for MapXtreme SCP (software copy-protected) and localized deployments are also identified. This table supersedes the table presented in Chapter 2 of the Developer Guide. However, the rest of the deployment section of the chapter provides current information.

1. Applications built using a localized version of MapXtreme 2005 have additional required merge modules.
1. See [Web Setup Project on page 26](#) for information on a related known issue in this release.
## Merge Modules Provided With MapXtreme 2005

<table>
<thead>
<tr>
<th>Name of Merge Module</th>
<th>Included Assemblies</th>
<th>Purpose</th>
<th>When to Use</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Custom Symbols</strong></td>
<td></td>
<td>Contains custom symbols</td>
<td>Include if your application expects to use the stock bitmap symbols</td>
</tr>
<tr>
<td>MapInfoCustSymb.msm</td>
<td>None</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Desktop</strong></td>
<td></td>
<td>Contains assemblies with .NET controls for use in C# and VB .NET desktop applications</td>
<td>Include if your application expects to use the Desktop tools</td>
</tr>
<tr>
<td>MapInfoDesktop_6.6.msm</td>
<td>MapInfo.Windows</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>MapInfo.Windows.Dialogs</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>MapInfo.Windows.Framework</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Fonts</strong></td>
<td></td>
<td>Contains MapInfo symbol fonts for Cartographic, Real Estate, Arrows, Miscellaneous, Oil&amp;Gas, Transportation, Weather, and Shields.</td>
<td>Include if your application expects to use the stock TrueType® fonts. <strong>Add this merge module by hand.</strong></td>
</tr>
<tr>
<td>MIFonts_6.1.msm</td>
<td>None</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Mapping</strong></td>
<td></td>
<td>Provides the core mapping functionality. They also install the common configuration and default reference files for these assemblies.</td>
<td>Required for all applications. MapInfoMXTConfig_6.6.msm is automatically included when Core Engine module is included.</td>
</tr>
<tr>
<td>Non-copy protected MapXtreme 2005:</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MapInfoCoreEngine_6.6.msm</td>
<td>MapInfo.CoreEngine</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>MapInfo.CoreTypes</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>MapInfo.WMS.Client</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>MapInfo.Windows.Printing</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Copy protected MapXtreme 2005:</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MapInfoCoreEngineIntl_6.6.msm</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MapinfoMXTConfig_6.6.msm</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## Merge Modules Provided With MapXtreme 2005

<table>
<thead>
<tr>
<th>Name of Merge Module</th>
<th>Included Assemblies</th>
<th>Purpose</th>
<th>When to Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Web Controls</td>
<td>MapInfo.Web</td>
<td>Installs the .NET assembly MapInfo.Web, and a number of web resources to be used in web-based applications. It also starts the ASPNetState service, and creates a virtual directory for the web resources (if IIS is installed).</td>
<td>Include if your application expects to use the stock MapXtreme 2005 web controls</td>
</tr>
<tr>
<td>MapInfoWeb_6.6.msm</td>
<td>MapInfo.WebControls</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Web Services Clients</td>
<td>MapInfo.Services</td>
<td>Contains the assemblies for geocoding and routing</td>
<td>Include if your application expects to use geocoding and routing</td>
</tr>
<tr>
<td>MapInfoServices_6.6.msm</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>WFS</td>
<td>MapInfo.WFS.Server</td>
<td>Contains the assemblies needed for WFS</td>
<td>Include if your application expects to use a Web Feature Service for data transformation</td>
</tr>
<tr>
<td>MapInfoWFS_6.6.msm</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## Merge Modules Provided With MapXtreme 2005

<table>
<thead>
<tr>
<th>Name of Merge Module</th>
<th>Included Assemblies</th>
<th>Purpose</th>
<th>When to Use</th>
</tr>
</thead>
</table>
| **WMS**
MapInfoWMS_6.6.msm | MapInfo.WMS.Server | Contains the assemblies needed for WMS | Include if your application expects to use a Web Map Service for retrieving digital images. |
| **For Localized Deployments**
MapInfoCoreResJPN_6.6.msm | MapInfo.CoreEngine.resources
MapInfo.Services.resources
MapInfo.Web.resources
MapInfo.WebControls.resources
MapInfo.Wfs.Server.resources
MapInfo.Windows.dialogs.resources
MapInfo.Windows.resources
MapInfo.Wms.Client.resources | Resources for localized versions | Include if you are building applications with, and deploying them to, Japanese or Chinese locales. See [Merge Modules for Localized and Copy-Protected Deployments](#) on page 9. |

### Merge Modules for Localized and Copy-Protected Deployments

When deploying applications for Japanese or Chinese locales, be sure to include the locale-specific merge module in your package in addition to MapInfoCoreEngineIntl_6.6.msm.

For example, for Japanese locales, include MapInfoCoreResJPN_6.6.msm. For Chinese, include MapInfoCoreResCHN_6.6.msm. These modules are only available with the purchase of MapXtreme 2005 Japanese or MapXtreme 2005 Chinese, respectively.

For deploying to English locales using MapXtreme 2005 SCP, you must include MapInfoCoreEngineIntl_6.6.msm.
What’s New and What’s Changed

MapXtreme 2005 offers the following new features and functionality in version 6.6 (v6.6).

- **Visual Studio 2005 Integration and .NET 2.0 Framework Support**
- **Normalization Tables for Nordic Character Sets**
- **Data Access from SQL Server 2005**
- **Coordinate System Enhancements**
- **UseCallContext**

**Visual Studio 2005 Integration and .NET 2.0 Framework Support**

MapXtreme 2005 supports the Microsoft .NET 1.1 and 2.0 Frameworks, which allow you to develop and deploy Windows-based desktop and web applications using a variety of supported programming languages and tools. This release of MapXtreme 2005 is fully integrated into the Visual Studio 2005 development environment. Templates and sample applications are provided for you to get started quickly with prototyping and developing.

The following topics are covered in this section:

- **Templates**
- **Sample Applications**
- **Templates and Samples Follow Best Practices**
- **MapXtreme 2005 Web Applications and Visual Studio 2005**

**Templates**

MapXtreme 2005 provides four types of templates for creating desktop and web applications in Visual Studio. Each type has a template for use with C# and Visual Basic.

- MapForm Application (contains MapControl and basic map tools)
- Web Application (contains MapControl, LayerControl, basic and navigational tools)
- Windows Application (blank form with no controls)
- Windows Console Application

In Visual Studio 2005, the desktop templates are accessible under File > New > Project. They are available for C# and Visual Basic.
The MapXtreme 2005 web application template can be found under File > New > Web Site. MapXtreme 2005 supports web templates in C# and Visual Basic. The language of the template is controlled by the Language drop-down box on the New Web Site dialog box.

Sample Applications

MapXtreme 2005 comes with a wide variety of desktop and web sample applications that cover basic and advanced MapXtreme product functionality. There are separate samples for use in Visual Studio .NET 2003 (supporting the Microsoft .NET 1.1 Framework) and for use in Visual Studio 2005 (supporting the Microsoft .NET 2.0 Framework). You will find the desktop and web samples located in their respective VisualStudio folders under \Program Files\MapInfo\MapXtreme\6.6\Samples\.

Note: MapXtreme 2005 samples for Visual Studio 2005 do not contain project files, as they are no longer necessary in Visual Studio 2005.
Source code for the web controls introduced in MapXtreme 2005 v6.5 are also located in the \Samples directory at [Program Files]\MapInfo\MapXtreme \6.6\Samples\Samples \WebControlsSourceCode. Use these controls in either Visual Studio .net 2003 or Visual Studio 2005.

Templates and Samples Follow Best Practices

MapXtreme 2005 templates and sample applications follow best development practices by using pooling for resource conservation and scalability, and by handling user state manually.

Pooling in MapXtreme 2005 means that multiple MapXtreme Session objects can be created and available for web requests.

Manual state means that only the changes the user makes to the MapXtreme Session object are stored in the HTTP session. This is in contrast to automatic HttpSessionState in which the entire MapXtreme Session object is stored automatically.


MapXtreme 2005 Web Applications and Visual Studio 2005

Visual Studio 2005 has enhanced its web development capabilities, as outlined by Microsoft at http://www.asp.net/learn/withpss/module1.aspx?tabid=1. Two major changes that affect MapXtreme 2005 include:

- ASP.NET Development Server
- FTP Web Applications

ASP.NET Development Server

One major enhancement is the addition of a new web development server called ASP.NET Development Server. This allows you to develop web applications against a local server without needing administrator rights.

To support this new server, MapXtreme 2005 now provides its resources in the web project location at design time when a MapControl is dropped on the form. In previous MapXtreme 2005 releases, resources were only available from the IIS virtual directory.

Note: If you make any changes to the resources, you must copy these files when you deploy your application.

FTP Web Applications

Also new in Visual Studio 2005 is the ability to create web sites via FTP. This requires that you create an FTP service under IIS Component Services. For instructions, see “Lab: Setup FTP site and create a project” in this document: http://www.asp.net/learn/withpss/module1.aspx?tabid=1.
Normalization Tables for Nordic Character Sets

MapXtreme 2005 now supports sort and commit operations for data created using Nordic character sets (Swedish, Finnish, Danish, and Norwegian).

MapXtreme 2005 has always read data in Latin1 character sets. However, for string comparisons such as Select and Update, only those languages that followed the English character set sorting order would yield correct results. Nordic character sets do not follow the English sorting order.

To support this behavior, MapXtreme 2005 now handles three types of sorting orders: English sort, Swedish/Finnish sort, and Danish/Norwegian sort.

For example, a Swedish table opened on a system using a Swedish locale, will now maintain the proper sort order for the language by following the rules laid out in the Swedish/Finnish normalization table. Norwegian tables opened using a Norwegian locale will maintain the sort order using the Danish/Norwegian normalization table. A table in Portuguese will follow the English normalization as there is no difference in sorting between Portuguese and English.

In the case of a Nordic table being opened on a computer using a non-native locale, MapXtreme 2005 follows the normalization table that matches the system to determine data sorting order operations. For example, for an order by operation on a Swedish table using an English locale, the data is returned using the English sort order. However, MapXtreme 2005 maintains the table’s index file using the Swedish normalization table so that any changes to the table, such as inserts or deletes, are maintained in Swedish.

If the table contains characters that are outside of the table’s alphabet, such as German characters in a Danish table, the foreign characters are handled correctly as well. This results in different indexing results from previous versions of MapXtreme as well as from current and previous versions of MapInfo Professional. Therefore a table created in MapXtreme 2005 v6.6 may have different results when opened in MapInfo Professional.

Data Access from SQL Server 2005

MapXtreme 2005 applications can access data stored in a Microsoft SQL Server 2005 database, provided that there exists a user account and an associated user schema that bears the same name. This is necessary due to new behavior in Microsoft SQL Server 2005 that allows for the separation of owners and schemas for enhanced security management.

Coordinate System Enhancements

This release includes support for a number of coordinates systems. In addition, EPSG codes were added to several coordinate systems. For a full list of coordinate systems, see the MapInfoCoordinateSystemSet.xml located in "C:\Program Files\Common Files\MapInfo\MapXtreme\6.x, where 6.x is the release version of MapXtreme 2005.
Newly Supported Coordinate Systems

The following are supported coordinate systems beginning with this release of MapXtreme 2005.

European Terrestrial Reference System (ETRS) based projections:

• Transverse Mercator Zones 26 through 39
• Lambert Conformal Conic
• Azimuthal Equal Area

Hellenic Coordinate System

• Hellenic XATT 24 Degree cent/merid

Estonian Coordinate System

• L-EST 97

Latvian Coordinate systems

• LKS-92 for large scale (EUREF89)
• Longitude / Latitude (LKS-92)

Lithuanian Coordinate Systems

• Longitude/Latitude (LKS-94)

South African Projections Clarke 1880 Cape

• Gauss-Krüger LO 33

South African Projections WGS 84

• Gauss-Krüger LO 17 WGS
• Gauss-Krüger LO 19 WGS
• Gauss-Krüger LO 21 WGS
• Gauss-Krüger LO 23 WGS
• Gauss-Krüger LO 25 WGS
• Gauss-Krüger LO 27 WGS
• Gauss-Krüger LO 29 WGS
• Gauss-Krüger LO 31 WGS
• Gauss-Krüger LO 33 WGS

Swedish conical conform projections for aviation maps - Lambert

• Aviation map AC 2090 B Kiruna
• Aviation map AC 2090 C Lule
• Aviation map AC 2104 AB Sundsvall
• Aviation map AC 2104 DC Gvle
• Aviation map AC 2152 AB Stockholm 2152 DC Gteborg
• Aviation map AC 2169 A Malm
• Aviation map Sweden longitude 15, (58 00, 66 00)
• Aviation map North Sweden longitude 15, (63 30, 67 30)
• Aviation map South Sweden longitude 15, (56 30, 60 30)

Finnish Coordinate Systems

• ETRS-TM35FIN0
• ETRS-TM35FIN (central meridian 8500 km)

**EPSG Codes Added**

The following coordinate systems have been updated to include EPSG codes:

• Gauss-Krüger (DHDN): GK Zone 1 (DHDN)
• Lithuanian Coordinate Systems: LKS-94 (EUREF89); Baltija-92 (EUREF89); Longitude / Latitude (EUREF89);
• Old Lithuanian Coordinate System: KS-1942 Zone 4 (Lithuanian Pulkovo 1942)
• Latvian Coordinate System: LKS-92 (EUREF89)

**UseCallContext**

MapInfo.Session.UseCallContext is now set to True by default. This is a change from previous releases. This is the expected behavior for web applications.

UseCallContext is a web.config setting that tells the web server where to get the session instance from when using Response.Redirect or Server.Transfer, either: call context-specific (True) or thread-specific (False). By setting UseCallContext to True the session instance remains the same within the lifetime of the ASP.NET request, regardless of which thread each part of the request executes in.

For desktop applications, performance may improve if you set UseCallContext to false. Follow these steps to create a config file for your project and add the UseCallContext setting.

**Creating a Configuration File for Desktop Applications**

1. Add a new file to the Visual Studio project by choosing "Add New Item" on the Project menu.
2. In the Add New Item dialog, choose Application Configuration File from the list of installed Visual Studio 2005 templates and click Add. App.config is now listed in your project.

   In Visual Studio .NET 2003, the Application Configuration template is located in the Utility folder under the Local Project Items.
3. Add the following **bold** text to the App.config file between the <configuration> tags and save the file.

   ```xml
   <configuration>
   <appSettings>
     <add key="MapInfo.Engine.Session.UseCallContext" value="false" />
   </appSettings>
   </configuration>
   ```
Bug Fixes

Memory Leak During Map Export

The situation whereby MapXtreme 2005 generates a memory leak when exporting a map containing raster layers has been resolved. Objects handled by the LeadTools raster handler were not being released by MapXtreme 2005. Image formats, such as JPEG, BMP or SVG, that use the LeadTools raster handler could generate a leak. Metafile image formats EMF or WMF were not affected.

Performance Issues Related to Operators

This release of MapXtreme 2005 contains performance enhancements for accessing data. Areas of improvement include projection expressions on indexed tables, the LIKE operator, and FetchNext. The result is records are returned faster and large map tables draw faster.

Workspace Manager

Labeling

Labeling in Workspace Manager has been fixed so labels can be dragged and dropped with the Select tool.

Print Preview

MapXtreme 2005 now correctly saves a MWS after you use PrintPreview.

Theme Wizard

The “Ignore Zero” checkbox in the Create Theme Step 2 of 3 in the Theme Wizard in Workspace Manager now works correctly. This option is available when creating Pie and Bar chart themes and IndividualValue themes on Features or Labels. Note that when this option is set, the performance of the theme building operation in Workspace Manager may be affected.

Japanese Characters

Workspace Manager now correctly displays Japanese characters in an Individual Value theme.

Label Tag

Adding a Label tag to a layer in Workspace Manager is working correctly.

DLL Loader Lock

The DLL loader lock exception has been corrected. This issue was encountered when running a v6.6 web application on a system with side-by-side installations of v6.5 and v6.6. The problem was traced to v6.5 and v6.6 assemblies (DLLs) that contained COM+ objects were being registered with
COM+ using the same application ID. When a pooled object was created in a v6.6 web application, assemblies from both versions of MapXtreme 2005 were loaded, even though the application correctly pointed to a v6.6 assembly. Since v6.5 assemblies do not run under the 2.0 Framework, they caused the loading process to lock.

Geocoding

Geocoding Client with Non-U.S. MapMarker Servers
MapXtreme 2005 now works properly when geocoding against non-U.S. versions of MapMarker that use the 2.0, 3.0 and 4.0 core engines.

Oracle

New Event and Method for OCI connections to Oracle RDBMS
MapXtreme 2005 contains an OnConnectionLost event that is fired when you attempt to use a OCI connection to an Oracle RDBMS that is no longer valid. This occurs, for example, when you attempt to carry out a data selection on an open table, but the connection no longer exists. MapXtreme 2005 reports an error if you attempt to use the lost connection.

The TestConnection method that is used to test the connection prior to firing the OnConnectionLost event is also a public method on the MapInfo.Data.DBMSConnection class. Use this method when you wish to test an OCI connection for a DBMS object.

This fix has not been implemented for ODBC connections.

Oracle NULL Centroid
MapXtreme 2005 now correctly calculates the centroids for objects in an Oracle layer if the object’s centroid is NULL. Labeling and other centroid-related operations will now behave as expected.

Oracle Instant Client
MapXtreme 2005 now connects to an Oracle table via OCI using the Oracle Instant Client.
Styles

Transparent Fill Patterns

Transparent fill patterns for regions now display correctly on the second and subsequent map rendering from a web service. MapXtreme no longer reverts to a default solid fill pattern.

The problem was specific to a MapXtreme session that was saved InProc and for which the web service method EnableSession was set to false.

Tables

Remote Table Error

MapXtreme 2005 no longer throws an error when you make a selection on a remote table and then exit the application from Visual Studio.

Themes

MultiVariable Themes

The Bar Chart height and width now display correctly when using the Modify Theme button in Workspace Manager. Previously the height and width would increase by a factor of 3 each time the button was clicked.

A similar issue was reported and fixed for pie charts; however, neither the pie or bar chart behavior was specific to the Modify Theme dialog. It is related to the scale of the map and how it affects the DataValueAtSize and Size properties of the MultiVariableTheme class. These properties control how large object theme geometries display at particular values. The default value for DataValueAtSize is set to the largest data value of the mapped features.

Web Controls

Fixes to Pre-v6.5 Web Controls

PolygonSelection Tool

The pre-v6.5 tool for selecting polygons (PolygonSelectionMapTool) has been fixed to use the more precise SearchWithinGeometry instead of SearchWithinDistance. This also matches the behavior of the PolygonSelectionTool released in MapXtreme 2005 v6.5.
Fixes to Current Web Controls

*Custom Tags for MapControl*

The custom tags for `<img>` tag for MapControl have been removed and replaced with javascript code.

*Radius Selection*

Clipping when using a radius selection web control now works correctly. This was fixed for both the current radius selection web control and its pre-6.5 version.

Other

*Marquee Zoom*

When performing a marquee zoom-out that extends beyond the bounds of the largest layer in the map, zoom layer restrictions are ignored. This is considered an extreme case that the zoom level was not designed to handle. To avoid this behavior, create a marquee box smaller than the extent of your largest map layer.

*Expanded Support for Character Sets*

MapXtreme 2005 has added support for a number of character sets to match those supported in MapInfo Professional. Previously MapXtreme 2005 could only read data if it was in a Windows character set or DOS 437.

*MapInfo.Data.IFeatureEnumerator*

Retrieving features using an MapInfo.Data.IFeatureEnumerator returns an MIDataReader that must be closed when you are through using it. This information is missing from the remarks for the IFeatureEnumerator Interface topic in the online Developer Reference. Close() is called automatically when MoveNext() returns false.
Known Issues

The issues that follow are those identified since the previous release of this product. They are either currently under investigation or in active development seeking a resolution.

Performance Issues Related to Large Tables

AddColumns
MapXtreme 2005’s performance can be very slow when you are adding columns to tables with more than 200,000 records. We recommend that you create the columns collection yourself (instead of passing in NULL). Include the geometry column only if you need it. Do not index the temporary columns unless you need to.

Inserting Records
Inserting records into a TableInfoServer table using MICommand takes a long time for a large number of records.

Range and Individual Value Themes
Range and Individual Value themes based on large tables draw slowly.

Data Access

RenditionType and RenditionColumn
MapXtreme returns an error if you attempt to insert a feature into a table when the entry in the MapInfo_MapCatalog for the table has the RenditionType set to 0 and the RenditionColumn set to null.

MapXtreme will not load a remote database table containing an MI_STYLE field if the RenditionType is set to 0 and the RenditionColumn is set to NULL in the MapInfo_MapCatalog.

Update Query for MS Access
Executing an update query on a MS Access table fails to insert style and object. For example:

```
insert into custpointswest (Obj, MI_Style) values ( newobject, newstyle))
```

However, if you only insert the Obj field, the query works, as below:

```
insert into custpointswest (Obj) values ( MI_Point (-121.331658,38.546608,'EPSG:4326'))
```
MS Access Failed Connections
MapXtreme Web applications that access Microsoft Access databases may experience failed connection attempts. This is due to a limitation in Microsoft's Jet database engine when used in a high-stress, 24 x7 server environment. The Jet database engine, the engine behind MS Access, is limited to 64 concurrent connections. This includes the number of tables across all threads. In high-stress web environments, the actual number of successful concurrent connections may be less. For more information, see the following Microsoft technical publication: http://support.microsoft.com/default.aspx?scid=kb;EN-US;q222135.

Microsoft recommends using MS SQL Server with IIS for web applications that require absolute data integrity or high user concurrency.

MI_Intersection
MapXtreme 2005 may error when a query using MI_Intersection is involved.

Case Statement
MapXtreme 2005 does not return the correct column alias when adding a table from Oracle that is a result of a query containing a Case statement.

Order By and Where Clause
Order By fails when the column selected is used for both the Order By and Where clauses. The results come back in the order listed in the where clause. For example.

```
Select PropertyId2 From PropertyParcels Where PropertyId2 = 225.84 OR PropertyId2 = 226.04 OR PropertyId2 = 225.46 Order by PropertyId2
```

incorrectly returns the records in the order listed in the Where clause: 225.84, 226.04, 225.46.

Order By and Group By
When Order By and Group By are used in the same query, Order By Desc is ignored. For example:

```
Select name from railways group by name order by name desc
```

The results are incorrectly returned in ascending order.

BaseTable Property
MapXtreme 2005 throws an error when you access the BaseTable property of an IResultSetFeatureCollection created from a query with a Group By clause.

Labels
The rotation handles that display for labels and legacy text that are selected do not operate. Additionally, the anchor point position cannot be changed.

Label visible range is not inclusive at MaxZoom in some situations. The visible zoom level varies due to the coordinate system, possibly due to rounding calculations.
Known Issues

Legends
- The BarTheme legend does not update to show scale after the map zoom level is changed. In place of the scale, a “Not drawn to scale” message displays.
- The LegendFrame.Rows.Visible property, when set to ‘false’, does not turn off the legend row as expected.
- Re-opening a workspace with a theme and saving it creates two legends in the workspace.
- Saving a map and an appended custom legend to a workspace results in an error.

Licensing
- The licensing in MapXtreme 2005 is unable to determine if an application is running as a desktop or web application when deployed as a Web Service. For web applications use a desktop runtime license along with your web runtime license.

Mapping

Exporting to EMF
- Exporting to EMF and viewing the EMF file in Microsoft Word displays more of the map than was originally exported.

Panning
- When panning a map that uses a scale range for visibility, white patches display over the map.

Map Center Point Incorrect After Pan and Zoom
- ASP.NET session state management problems can occur when using StateServer and SqlServer under .NET 2.0 framework. When performing a zoom or pan operation on the map, the new center point of the map image is offset incorrectly. This problem was encountered only in Visual Studio 2005 using the 2.0 Framework.

DisplayTransform.ToDisplay

Node Editing
- The Select tool does not behave correctly in Layer Control when Allow Node Editing is turned on.

Printing
- Adornments are not positioned correctly when printing.
Raster Images

MapXtreme 2005 is unable to open ESRI Grid or ERDAS IMAGINE (.IMG) raster files in Workspace Manager.

Sample Applications

Thematics sample web application on Netscape/Firefox: In order for this sample application to render properly and for the pan tool to work correctly, the following changes are needed in the webform1.aspx file:

- In the parent element <td> of the <LayerControl> element, change the style as follows to add the display:block:
  
  `<td style="display:block;position:relative">`

- Change the LayerControl style positioning from absolute to relative (i.e. position: relative).

Sample Code

In the MapXtreme Developer Guide, the VB code example for customizing the AddPolygonTool does not compile. Use the following code in its place:

```vbnet
Dim insertionlayerfilter As IMapLayerFilter
Dim style As MapInfo.Styles.CompositeStyle
Dim addmaptoolproperties As MapInfo.Tools.AddMapToolProperties
Dim maptool As MapInfo.Tools.MapTool

insertionlayerfilter = MapLayerFilterFactory.FilterByLayerType(LayerType.Normal)
style = New MapInfo.Styles.CompositeStyle

```

Serialization

You cannot deserialize an ASCII PointRef table if the reference table is closed. You must first deserialize the pointRef table and then close the reference table.

When using ranged themes, do not clear the theme before deserializing it. This will result in differences in the theme properties between the serialized and deserialized theme.
Known Issues

**Selectability**

Layer selectability and editability settings are not visible for a layer unless that layer is both visible and zoom visible.

**Label Selectability**

The selectability option for Labels is not working correctly. Selectability cannot be turned off.

**Styles**

The black halo for a Text style is not displaying correctly. This is observable in the TextStyleDlg and StyleSampleBitmapButton object (button on the Style tab). As a workaround, choose a very dark gray as the halo instead of black.

The Symbol style for a Graduated Symbol theme is not properly reflected in the Layer Control. Graduated Symbols appear correctly on the map but are represented by a different symbol in the Layer Control.

**Disposing CompositeStyles**

CompositeStyles do not contain a way to free the resources used, causing memory leaks under some conditions. In the following code example, to avoid a memory leak, set the CompositeStyle to null.

```csharp
private MapInfo.Styles.AreaStyle _style = new MapInfo.Styles.AreaStyle();
for (int i = 0; i < 1000000; i++)
{
    MapInfo.Styles.CompositeStyle cs = new MapInfo.Styles.CompositeStyle(_style);
}
cs.AreaStyle=null;
```

**Regions with White Border**

Region features display with a white border when a null border is selected.

**Tables**

**WriteTabFile()**

TableInfoView.WriteTabFile() doesn't write out the CharSet property, resulting in the default value (Latin1) being used.
Double Byte Characters
Unable to create a table if the field names contain double byte characters. An error occurs when creating a table using TableInfoNative or AddField method. If Temporary is set to true, no exception is thrown. However, if you call TableInfo.WriteTabFile, you will see unreadable characters in the resulting file.

Alias
You cannot change the alias of a FeatureCollection returned from a Search. The exception string and online documentation does not include this information.

SpatialSchemaXY
If you specify a style column when attempting to load a remote database table through SpatialSchemaXY, the points do not display.
Update operations on a MapXtreme Catalog for a Microsoft Access database fail when a SpatialSchema object is used.

Editing a MapXtreme Table in MapInfo Professional
Adding features to the DefaultSelection after clearing them locks the table and cannot be edited in MapInfo Professional.

Vertical Mapper GRD Files
MapXtreme 2005 locks a Vertical Mapper GRD file during use, preventing further operations on the file outside of MapXtreme 2005. For example, the file cannot be edited with the VM SDK method vmWriteGRDRow nor can it be deleted from a user’s system through Windows Explorer.

Oracle Views
MapXtreme 2005 is unable to search on an Oracle view that is based on a table with a style column that is named something other than MI_STYLE.

Tools

InfoTips
InfoTips do not display when you hover over a feature on the map with the Select tool. The InfoTips will display if you select the feature.

Rectangle Select Tool
The RectangleSelect tool in MapXtreme 2005 may draw slower than expected when the map contains Oracle Spatial layers. To avoid this issue, clear the Show InfoTips checkbox for the layer(s) in Workspace Manager.
DOCTYPE in Visual Studio 2005

Web tool behavior works as expected on Internet Explorer, NetScape and FireFox when the following DOCTYPE is provided in the webform:

```xml
<!DOCTYPE HTML PUBLIC "-//W3C//DTD HTML 4.0 Transitional//EN">
```


In Visual Studio 2005, the default DOCTYPE is:

```xml
<!DOCTYPE html PUBLIC "-//W3C//DTD XHTML 1.0 Transitional//EN" "http://www.w3.org/TR/xhtml1/DTD/xhtml1-transitional.dtd">
```

The two DOCTYPEs may represent values in different Javascript properties. This results in the current scripts exhibiting unusual behavior.

For example, when the DOCTYPE DTD HTML 4.0 Transitional is used, scrollTop and scrollLeft are represented in document.body.scrollTop/Top. But when a different DOCTYPE, such as DTD XHTML 1.0 Transitional, is used, scrollTop and scrollLeft may be in document.documentElement.scrollTop/Top properties. Additionally, there may be issues with the positioning of elements.

To avoid issues such as these, when working with MapXtreme web controls, we recommend using DTD HTML 4.0 Transitional DOCTYPE in your MapXtreme web application.

MapForm Designer

The MapForm designer in Visual Studio 2005 throws errors when you load a map into a MapControl, then close the map before rebuilding the application. This happening regardless of the type of template (MapXtreme or Windows) or programming language (C# or VB) you use. As workaround, be sure to rebuild your application after loading a map.

ASP.NET 2.0

If you create a web application in Visual Studio 2005, you must manually switch the virtual directory to use asp.net 2.0, or the page will not load.

To switch the virtual directory to run asp.net 2.0, in IIS Manager, navigate to your virtual directory and right click to display the Properties dialog. In the ASP.NET Version drop-down list, choose the 2.0 tag.

Web Setup Project

If you create your own deployment for a web application in Visual Studio 2005, you will need to add the MSMs manually. The web setup project does not detect the assemblies that are referenced within Web.config; thus the assemblies (and the corresponding MSMs) are not detected as dependencies.
To add the MSMs manually, right-click on your web setup project and choose Add: Merge Module. Select MapInfoCoreEngine_6.6, MapInfoMXTConfig_6.6, MapInfoWeb_6.6 and any other MSMs you need.

Setup Project with Side-by-Side Installations

If you have a side by side installation (e.g., v6.5 and v6.6) on the same machine and you create a setup project for a MapXtreme 2005 v6.6 project within Microsoft Visual Studio 2005, the earlier versions of the mapinfocoreengine[intl] and mapinfomxtconfig MSMs will also be detected as dependencies.

You should exclude the earlier versions of the MSMs to create an efficient setup project. Right click on the earlier version and choose Exclude.

Note: The detection of previous versions of the MSMs is not the behavior of Visual Studio 2003, only Visual Studio 2005.

Source View

The Visual Studio 2005 templates open to the "Source" view instead of the "Design" view.

Web Applications

Web Template Web.config for Non-English Operating Systems

On some non-English operating systems, the web.config file that is generated by the MapXtreme 2005 ASP.NET web template does not contain the correct path to the world.mws file. The correct path is C:\Programmer\MapInfo\MapXtreme\6.6\Samples\Data\World.mws.

Web Gardens

The initial page of a web application fails to load when using the web controls in an application pool on a Windows 2003 Server which has its web garden set to more than one. This happens because the server code creates an image cache on the server process to hold the generated image and then sends the page to the client with the img.src pointing back to this cached image. The problem arises in a web garden when the first request is sent, it happens in worker process 1 and the next request to get the image is sent to the other worker process (wp2). Since the image is cached on the first worker process the request fails. This is the same for load balanced distributed applications.

To replace the red X that displays in place of the expected image, use a recenter tool on the image window and you will get the correct image. The web gardens cycle through the image requests and switch between the worker processes. This was not an issue with the pre-v6.5 web control design as it did not support web gardens.

To avoid using the cached image on the initial page_load, you must make a change in the web controls source code, either to MapControl.cs or MapControl.vb. The source files are located in [Program Files]\MapInfo\MapXtreme\6.6\Samples\WebControlsSourceCode\<cs><vb>\MapControl.
MapControl.cs

The change does not use the cached image on the initial page_load. Instead the img.src tag directs the browser to fetch the image live. In the RenderContents() method of MapControl.cs, make the changes that are highlighted in bold:

```csharp
protected override void RenderContents(HtmlTextWriter output)
{
    // Get the model out of ASP.NET and get the stream
    MapControlModel model = MapControlModel.GetModelFromSession();
    if (model == null) model = MapControlModel.SetDefaultModelInSession();

#if USE_CACHED_IMAGE
    MemoryStream ms = null;
    try{
        ms = model.GetMap(MapAlias, (int Width.Value, int Height.Value,
            ExportFormat.ToString());
        catch(Exception ex) {
            output.WriteLine(ex.Message);
            output.WriteLine("<br>");
            output.WriteLine(L10NUtils.Resources.GetString("MapNotFoundErrorString";
            return;
        }

        // Insert the image stream to Cache with key imageid and timeout in 2
        // mintues.
        string imageid = ImageHelper.GetUniqueID();
        ImageHelper.SetImageToCache(imageid, ms, 2);
        string url = ImageHelper.GetImageURL(imageid,
            ExportFormat.ToString());
#else
    string url =
        string.Format("MapController.ashx?Command=GetMap&MapAlias={0}&Width={1}&H
            eight={2}&Left=0&Top=0&Right={3}&Bottom={4}&ExportFormat={5}",MapAlias,
            Width.Value, Height.Value, Width.Value, Height.Value,
            ExportFormat.ToString());
#endif
    ```
MapControl.vb

In the MapControl.vb source file, the change is highlighted in bold:

```vbnet
Protected Overrides Sub RenderContents(ByVal output As HtmlTextWriter)
    ' Get the model out of ASP.NET and get the stream
    Dim model As MapControlModel = MapControlModel.GetModelFromSession()
    If model Is Nothing Then
        model = MapControlModel.SetDefaultModelInSession()
    End If
    Dim url As String = Nothing
    If False Then
        Dim ms As System.IO.MemoryStream = Nothing
        Try
            ms = model.GetMap(MapAlias, CType(Width.Value, Integer),
                CType(Height.Value, Integer), ExportFormat.ToString())
            Catch ex As Exception
                output.WriteLine(ex.Message)
                output.WriteLine("<br>")
                output.WriteLine(L10NUtils.Resources.GetString("MapNotFoundErrorString"))
                Return
            End Try
        Dim imageUrl As String = ImageHelper.GetUniqueID()
        ImageHelper.SetImageToCache(imageUrl, ms, 2)
        url = ImageHelper.GetImageURL(imageUrl, ExportFormat.ToString())
        Else
            url = String.Format("MapController.ashx?Command=GetMap&MapAlias={0}&Width={1}&Height={2}&Left=0&Top=0&Right={3}&Bottom={4}&ExportFormat={5}", 
        End If
```
Select Tools

Area select tools' "selection area" is incorrectly offset when drawn in ASP.NET VB web applications created in Visual Studio 2005. This happens when you create an ASP.NET web site and include MapXtreme 2005 assemblies. The DOCTYPE on the form is not the recommended type for MapXtreme web applications. See DOCTYPE in Visual Studio 2005 on page 26 for the recommended DOCTYPE.

Browser Back Button and pre-v6.5 Web Controls

In a web application, if you zoom in on one area of a map, click the Back button, and zoom in on another area of the map, the previous zoom view displays. The Forward and Back browser buttons are disabled. This applies to the pre-v6.5 web controls only.

Pre-v6.5 web InfoTool

The pre-v6.5 web InfoTool selects features incorrectly and inconsistently. The expected behavior is that the tool selects objects that intersect the select point within a certain pixel tolerance. Currently it selects objects that have a minimum bounding rectangle (MBR) that enclose the clicked point. These MBRs may have larger or smaller tolerances. This feature does not exist in the new Web MapControl.

ExitProcess Key

The ExitProcess key in the web.config file is set to true by default, which may cause an error when debugging your application. A Microsoft issue required that the setting default to be ‘true’, but that issue has since been resolved. Override the default value for the ExitProcess key by setting it to false.

Microsoft vgx.dll

The Web tools for distance and polygon selection causes MapXtreme to crash after multiple uses of the tools. This is not specific to MapXtreme, but to a bug in Microsoft’s vgx.dll. According to Microsoft, when you view a Web page in Microsoft Internet Explorer 6.0, IE stops responding or crashes, and you receive an access violation in vgx.dll. This problem occurs if the Web page renders vector graphics on the screen and if your computer is running Microsoft Windows XP Service Pack 2 (SP2). For more information see http://support.microsoft.com/?scid=kb;en-us;885932. A workaround for those who do not want to install the Microsoft KB885932 fix is to increase the COM+ activation time (for example, from 60000msec to 120000msec).

Web Controls

MapAlias Is Required at Design Time

You must set a MapAlias value every time you add a MapControl to a WebForm. If the MapAlias is not set at design time, your application will not run properly, resulting in a crash. Further, if you change the MapAlias value at runtime, an error will result from the application looking for the original MapAlias.

The MapXtreme 2005 web template and samples provide a default MapAlias called “Map1”.
MapXtreme 2005 v6.6 Release Notes

MapAlias and Pre-Loaded Workspaces
If a MapAlias is not provided or if the MapAlias provided does not exist, the MapControl will display the first available map listed in your pre-loaded workspace. During design-time, if you remove and replace the MapControl, the template does not assume the MapAlias remains the same. It may also be NULL. In this case, MapControl still displays the first available map in the preloaded workspace.

Because of the state management code in the MapXtreme 2005 template, it is important that the MapAlias remain consistent at run-time. The MapAlias is the key to tying a user’s settings to its session. If you need to change the MapControl’s MapAlias at run-time, you must provide additional code for your specific needs.

MapAlias and Session Management
Changing to a different MapAlias for a MapControl at runtime restores incorrect session values. The default session management settings in MapXtreme 2005’s project templates and sample applications only store changes to the HTTP session, rather than the entire session. As stated in the above known issue, the MapAlias is the key to tying the changes to the correct session. If the MapAlias is changed at runtime, the session will return state that was for the previous MapAlias.

Web Controls and HTML 4.0.1 Compliancy
MapXtreme 2005 generates valid HTML 4.0.1 compliant code from its current and pre-v6.5 web controls when using Visual Studio .net 2003. However, the controls are still an issue when using Visual Studio 2005.

The web resource MapXtremeWebResource 6_6 contain a space in its path. While this works properly, the path does not follow best practices for URLs.

Radius Select Rubber Band
The RadiusSelect web control sometimes displays its rubber banded area cut off.

MapControl Height and Width Settings
Setting the width and height properties for a web MapControl using percentage values causes display problems.

LayerControl Visibility Behavior
The web LayerControl may exhibit incorrect behavior when checking or clearing visibility check boxes for themes or style overrides. If the LayerControl contains multiple themes and/or style overrides, checking the box for one layer, checks the boxes for all of them. This does not occur when using LayerControl in Workspace Manager.

PointSelectionTool
The web PointSelectionTool cursor hotspot is not at the expected location (top of finger). This makes it difficult to know how to click precisely on an object.
Known Issues

Pixel Tolerance
Setting the PointSelection tool’s PixelTolerance property to 0 (zero) will result in a crash at runtime. The exception that is thrown states “Specified argument was out of the range of valid values.” Use a positive integer when setting PixelTolerance.

Pan/Zoom
When using the Pan tool at runtime, right-clicking in the map will cause the shortcut menu to display. If you left-click off the menu to hide the shortcut menu, the map will pan from your first to second click, regardless of the first click being a right-click. Similarly, when using the Zoom In or Zoom Out tool at runtime, the map will zoom either in or out using the same right-click scenario, as though both clicks were left-clicks.

LayerControl
When adding a layer from temporary table to the map, the LayerControl will crash. This occurs when the <appsettings> in the web.config file for the application are set like the text below:

```
<add key="MapInfo.Engine.Session.Pooled" value="false" />
<add key="MapInfo.Engine.Session.State" value="HttpSessionState" />
<sessionState mode="StateServer" stateConnectionString=
"tcpip=xxx.x.x.x:xxxx" sqlConnectionString="data source=xxx.x.x.x;user id=sa;password=cookieless="false" timeout="20" />
```

Note that these settings are not the recommended settings for MapXtreme 2005. The project templates and samples use pooling, manual Session.State and InProc sessionState mode. This gives you more control over what is saved for each HTTP session. See Chapter 5 in the MapXtreme 2005 Developer Guide for more on best practices when planning applications.

WMS/WFS
Workspace Manager errors when you select Map > View Entire Layer for a WMS Table version 750.

Miscellaneous Issues

MessageBox
Putting a message box in a window (form) constructor prevents marquee zoom in and zoom out tools from working. To avoid this situation, put the MessageBox call in the form’s Load event handler method.

Viewing the Learning Resources in Netscape
If you are running Netscape as your default browser, the MapXtreme 2005 Learning Resources may not initially display properly. If you launch the Learning Resources and it appears with blue links and missing image icons, right-click anywhere within the Learning Resources and select Display like
Internet Explorer to correct the display issue. Once you select this option, the Learning Resources will always display correctly for you. This option will not affect your viewing preferences for other browser content or web sites.

Printing Test Results

The following are observations made during the development and testing of MapXtreme 2005’s printing feature on the .NET 1.1 Framework\(^1\). These results focus on the behavior when using special drawing attributes. The output may or may not be as expected since many factors are involved (printer driver, print method and drawing attribute). This section will help you make some informed choices.

For an overview of printing from MapXtreme 2005, see Appendix H in the Developer Guide. For the online object model documentation, see the MapInfo.Printing namespace.

Map Drawing Attribute Test Results

Map size, paper orientation, and paper size had no affect on printing results. Drawing attributes, print method (to EMF or direct to device), and choice of printer driver do affect the printed output and the display in Print Preview. The following describes our testing results for these drawing attributes:

- Polygons with Holes
- Transparent Raster
- TrueColor
- Bitmap Pattern Scaling
- Transparent Vector Patterns

Polygons With Holes

Setting the value of DrawingAttributes.SpecialPolygonHoleHandling property to true and printing with a PCL printer driver will correctly print polygons with holes. If printing with a Postscript driver, you may see lines stretched across the hole, but they are less noticeable than if SpecialPolygonHoleHandling is set to false. The lines may be visible in PrintPreview.

Set this value to false when you are drawing to the screen.

Transparent Raster

When printing to a printer using a PCL driver, choose either print method (to EMF or direct to device) and set DrawingAttribute.SpecialTransparentRasterHandling property to true. Setting this to false for either print method will print the transparent area of a raster image black.

---

1. Some driver/printer combinations may behave differently than described in this section when used under the .NET 2.0 Framework.
**Tips for Printing Transparent Raster Layers**

The following can be tried if your map containing transparent raster layers print black. Note transparent raster printing is printer driver dependent. Not all printer drivers handle the raster operation (ROP) successfully.

- Choose MapPrinting.Print method to print to enhanced metafile (EMF).
- Use MapXtreme’s ROP method to display transparent raster. Turn off special handling of transparent raster (set to false) when printing.
- Print in true color (24-bit) if possible.
- For printing to HP plotters, use HPGL/RTL driver instead of a PostScript driver.

**Translucent Raster**

Printing translucent raster images from MapXtreme 2005 is not supported.

**True Color**

When printing images that have more than 256 colors to a device that only supports 256 colors, dithering is required. There are 2 types of dithering available - halftone and error diffusion. They each produce images that resemble the original image, except that they are using less colors. You'll have to determine which method is more appealing to you.

**Bitmap Pattern Scaling**

MapXtreme 2005 supports two types of hatch patterns that are used to fill polygons. If you look at the Area Style dialog in Workspace Manager, you will see samples of the available patterns (Right-click on a polygon layer and choose Add Style Override. Click the Area Style button on the Visibility tab to show the Area Style dialog). The first 7 patterns are Microsoft standard vector hatch patterns. The remaining fill patterns are MapInfo’s bitmap hatch patterns. Each type of pattern behaves differently when scaling for print.

Scale is printer-driver dependent; however, not all printer drivers support scaling. You must decide whether MapXtreme or your printer driver will handle it. Choosing not to scale at all results in printed output containing very small bitmap patterns that almost look like a solid color. When MapXtreme or the printer driver handles scaling, the printed result should look like the pattern on screen. If both MapXtreme and the printer scale, the printed output will be abnormally large.

To enable scaling from MapXtreme, programmatically set the DrawingAttributes.ScaleBitmapPatterns property to true. Patterns will be scaled up to compensate for the difference between printer and screen resolution.

To disable scaling from MapXtreme, set the DrawingAttributes.ScaleBitmapPatterns property to false. Your printer driver will take over if it supports scaling.

**Note:** This discussion covers scaling for non-transparent bitmap fills. Transparent fill patterns are always scaled.

When you print using a PostScript driver Language Level 1, disable scaling in MapXtreme. You will notice that the Print Preview will display larger than the printed output.
For PCL 6 printer drivers, turn off scaling in MapXtreme. Print Preview and print output will be the same quality and relative scale.

For PCL 5e printer drivers, enable scaling from MapXtreme. The printed output will scale properly.

### Printing With Transparent Vector Patterns

When using a PostScript driver, `SpecialTransparentVectorHandling` must be set to true, otherwise MapInfo transparent fill patterns will print black.

When using a PCL 5e driver, `SpecialTransparentVectorHandling` must be set to true, otherwise fill patterns will print very finely.

When printing with a PCL 6, `SpecialTransparentVectorHandling` does not need to be set true or false.

Overall, the PCL 6 printer driver was found to be the most suitable driver to print MapInfo and Microsoft transparent and non-transparent vector fill patterns. The printed output will match PrintPreview. It does not matter if `SpecialTransparentVectorHandling` is set to true or false. However, `ScaleBitmapPattern` must be false (unless your printer driver does not scale patterns).

When printing using a PostScript driver, set it to Language Level 1 when scaling MapInfo bitmap patterns. Additionally, transparent vector handling and scale pattern both need to be set to true. You can print both MapInfo and Microsoft transparent and non-transparent vector fill patterns successfully. However, the Print Preview for non-transparent MapInfo bitmap pattern will not match the printer output.

PCL 5e also requires transparent vector handling and scale pattern set to true. Print Preview for non-transparent MapInfo bitmap pattern will not match the printer output. PCL 5e does not handle non-transparent Microsoft vector fill patterns.

With any of the above testing printer drivers, if `ScaleBitmapPattern` is true, the Print Preview will not match the print output.

### Transparent Vector

The setting `DrawingAttributes.SpecialTransparentVectorHandling` allows you to manage the printing of transparent vector fill patterns. Factors that affect this are the printer driver and the setting for scaling bitmap patterns.

When using a PCL 6 printer driver, set the `SpecialTransparentVectorHandling` to false to print good quality transparent Microsoft and MapInfo vector fill patterns. If set to true, the print quality decreases somewhat: the pattern is edgier and not as clear as when the setting is false.

When printing using a PCL 5 printer driver, set `SpecialTransparentVectorHandling` to false. MapInfo vector patterns do not scale at all. Microsoft’s standard vector patterns print well. `SpecialTransparentVectorHandling` set to true does not print correctly.

When printing with a Postscript driver, setting `SpecialTransparentVectorHandling` to false prints transparent fill patterns well, but they do not scale. A true setting yields similar output to a PCL 6 driver true setting: edgier and less clear than a false setting yields. There were similar findings for a Plotter using a PostScript driver.